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Trademarks 

T-Mobile and T-Mobile Communication Centre are registered trademarks of 
Deutsche Telekom Group. 

Windows 98SE, Windows 2000 and Windows XP are trademarks or registered 
trademarks of Microsoft Corporation. 

Nokia, GPRS PC-card from T-Mobile and other products mentioned are trademarks or 
registered trademarks of their respective owners. 

Bluetooth is a trademark owned by Bluetooth SIG, Inc. 
Other product and brand names may be trademarks or registered trademarks of their 
respective owners. 

 

Disclaimer and Limitation of Liability 

T-Mobile assumes no responsibility for any damage or loss resulting from the use of this 
handbook.  

T-Mobile assumes no responsibility for any loss or claims by third party, which may arise 
through the use of this software.  

T-Mobile assumes no responsibility for any damage or loss caused by deletion of data as 
a result of malfunction, dead battery, or repairs. Be sure to make backup copies of 
important data on other media to protect against data loss.  

 

Important: Please read and accept the End User Software License Agreement with this 
product before using the accompanying software program(s). Using any part of the 
software indicates that you accept the terms of the End User Software License 
Agreement. 

 

 

Document Version 2.5.002 

Copyright T-Mobile under license from Alice Systems AB.  Solution includes patents pending for Alice Systems AB. 
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Introduction 

The T-Mobile Communication Centre Software is an innovative software solution for 
laptops which facilitates access to numerous mobile office communications functions. 
The solution allows users to connect and browse on Internet wirelessly and to reach 
their internet content or e-mail accounts as well as key in and send text messages 
(SMS) without difficulty over the graphical user interface. 

The Communication Centre Software is installed and configured within a few 
minutes. The intuitive interface is based on colour symbols and therefore provides 
the laptop user with easy access to all key office functionalities. Just one click on the 
appropriate icon will set up a connection to Microsoft Outlook, for example, or to the 
Internet. Technical processes like authentication, network login and activation of 
security mechanisms – for instance when accessing corporate networks – run 
‘automatically’ in the background. 

The Communication Centre Software also offers advantages for the IT administrator. 
The functions of the Communication Centre can be administered via an expert 
installation mode. Thus a company’s IT administrator can once centrally record the 
settings for all employees in the Communication Centre Software and directly 
integrate, for example, specific company applications and VPN clients in the 
software. The administrator can then distribute this version of the Communication 
Centre, which is specially customized to the needs of the company, to employees as 
an installation package. 

The intention with this document is to describe how to customize and configure the 
Communication Centre Software to comply with individual requirements as subject to 
company guidelines. 
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1 Pre-Configuration 

After the Communication Centre Software is installed on your laptop, it will 
automatically detect default device and assign them to any of the supported 
bearers (UMTS, GPRS, WLAN, LAN). If the device scan could not uniquely identify the 
default devices, you will be prompted to configure a default devices upon first start 
up. This is necessary for you to be able to establish a connection via any of the 
bearers. 

 

The Communication Centre Software supports an automatic device detection to 
make it easy to use for you. Nevertheless, if you want to use another device you can 
choose them manually or you need to install the device drivers accordingly as 
described in the Getting Started Guide.  

You may also assign additional default devices manually. Highlight the bearer that 
you want to assign a default device and click on the Select… button. You are able to 
change the default devices anytime by accessing the Device Manager within the 
Options | Preferences menu. 
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Communication Centre Software will be installed providing a basic configuration, 
enabling ready-to-go Internet connectivity using T-Mobile network services. The 
profile “Mobile” is set as Active Profile. This profile contains all preconfigured ready 
to go Internet connections. All Tasks and the Connect/Disconnect button will 
automatically connect to the Internet via the available bearer type with the highest 
performance. 

 

Communication Centre Software will provide you with two pre-configured tasks. You 
may start one of these tasks from the Launchpad area, by clicking the respective 
button. Further buttons can be configured with specific tasks. 

 Upon clicking the preconfigured e-mail task button an Internet connection will 
be established and afterwards the standard e-mail client on your laptop will be 
started. 

 Upon clicking the preconfigured Internet task button an Internet connection 
will be established and afterwards the standard Internet browser on your 
laptop will be launched. 

 

It is also possible to connect with any pre-configured 
connection manually by using the context menu of the 
Connect button. Click on the small triangle of the Connect 
button to choose among available connections out of the 
Active Profile. Select one connection entry to click on, and 
Communication Centre tries to establish a communication 
channel with that network.  
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When a connection is active, the Connect button turns into a 
Disconnect button. You may terminate a connection by clicking  
the red highlighted Disconnect button. 

 

With this basic configuration you don’t need to have any knowledge about specific 
settings in order to get going with the software. All what will remain for you to do is to 
install and select a default device for the different bearer types you want to use.  

Of course, you may also create your own customised configuration based on your 
specific needs and maybe distribute it to other users. This feature is very helpful for 
any company using particular networks, i.e. a certain configuration could then be 
distributed to a number of users.  

How to create your own connections and profiles and when to use the distribution of 
settings will be explained in detail later on in this manual. 

 

2 Configuration 

This section is dedicated to advanced users they want to benefit from maximum 
customization of network configuration and other advanced settings. Other users 
than advanced users please ask your administrator for any configuration to be 
imported into the Communication Centre Software. 
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The Communication Centre’s functionality is based on the methodology of 
Connections, Profiles and Tasks. Any Connection can be configured according to the 
specific settings for WLAN, UMTS and GPRS. A Profile consists of one-to-many 
Connections. In a Profile the user can decide which connections to be considered 
and in what priority they shall be used. 

 

 

 

 

 

Upon a profile, a Task can be added to the Launchpad. Each Task results in a button 
in the Launchpad. Tasks can be defined to use a particular profile or take the activate 
profile. In a simple manner, a task might just start an application without connectivity. 

Enter the Configuration by clicking the Options menu and then Configuration. 

Connections define general network 
connectivity settings like IP, Proxy, 
PPP and Security. In addition, it is 
possible define Windows applications 
that will be launched once a 
connection was successfully 
established. 

Connection Profiles contains one or 
several different connections in a 
priority list. The user sets the priority in 
which Communication Centre will 
connect using these connections. 
Furthermore, it is possible to launch Windows applications on a profile level, no 
matter which connection was established. Application launched from here will be 
launched when connecting with any out of the connections defined in the profile. 

The Select Active Profile is the users choice of preferred profile. It is useful to have 
different profiles for example one for the office, one profile for travelling and one for 
being at home. 

Tasks are for configuring buttons in the Launchpad. With a task it is possible connect 
with a profile and to launch applications. These tasks will be set up as buttons in the 
Launchpad (except for the ‘Default Connection’) and they do not have to be 
associated with a specific connection. Tasks is launched from the Launchpad in the 
Communication Centre. 

Profiles  
(Mobile,  

Office, etc.) 

 

Button/Task 

Connections  
(WLAN,  

UMTS, GPRS) 

Applications 

(ex. Outlook) 

Login Modules 

 

Applications 

(ex. VPN) 

Applications 

(ex. Compression) 
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2.1 Connections 

Clicking the connections tab 
allows the user to see all 
existing connections sorted per 
bearer. The user can add or 
delete connections, and even 
edit the properties of an 
existing connection. 

When adding a new 
connection the user needs to 
enter a connection name. The 
connection name will be the 
alias name used to configure 
profiles or just to connect to 
this network.  

Now the user has to set the 
bearer type among the available bearers (UMTS, WLAN, LAN and GPRS). Click on 
the button Settings to set the bearer specific parameters depending on the selected 
bearer type. The bearer specific parameters are defined in the Connection settings 
on page 15. 

Using the Usage thresholds option makes it possible to limit the usage either by 
time being online or amount of data sent/received over that connection. The time and 
volume limit can be measured between a given time period and recurrence, i.e. in 
accordance with the start date of your billing period (you can find this information on 
your monthly phone bill). 

The Applications tab contains configurations of applications to be launched after a 
connection was set up successfully. See page 24 on how to create a new application 
to be launched. 

2.2 Connection Profiles 

Here it is possible to add different 
profiles. Different profiles are useful if 
the user knows that he has access to 
different bearers under specific 
circumstances. For example at home, 
while travelling or in the office. Click the 
Connections button to create 
connections of any bearer. 

In the Settings the user can select 
which connections he wants the 
Communication Centre to check for 
connectivity possibilities. Under 
Selected Connections it is possible to 
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decide the priority of the connection types. For example, if it is preferred to connect to 
WLAN first and then UMTS. You can change the priority by the move Up and Down 
buttons. The Connections button to the right enables a quick switch to the 
Connection settings.  

In the Applications tab it is possible to set applications to launch after the preferred 
connections is established. This is called global application(s) launch. To see how to 
configure an application launch see page 24. 

 

2.3 Select Active Profile 

With the Communication Centre the user can define various useful profiles which will 
be used in individual situations, i.e. while being abroad or just somewhere on the 
road, being at home or in the office. After finishing the installation, there are three 
profiles pre-configured that can be used with the Communication Centre. The user 
can set one of these profiles as the active one. By doing this, you can define which 
profile that is used by the Communication Centre to establish a connection. 

By default, the profile “Mobile” is set to be the active profile. Selecting another profile 
out of the list view and then clicking on the button “Set Active” will activate the latest 
chosen profile. 

2.4 Tasks 

Under this menu the user can configure Tasks. A task can consist several actions 
linked to a button in the Communication Centre Launchpad (see figure). 

 

In most cases the task will also be linked to a Connection Profile. To configure a 
Task, you have to define: 

1. Name: This name will appear in the launch pad area if the view text labels is 
selected as well as the launch pad.  

2. Icon: Select an icon from the list proposed for the button. 

3. Tooltip: Optionally you may create a tooltip text which will be shown when the 
mouse pointer is positioned over the task button. 

4. Connection Profile: Select if the task shall be associated with a connection 
profile. 
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5. Launch Application: It is possible to configure one or more applications to be 
launched automatically from the button. Depending on what type of 
application the user selects different settings may be available. For specific 
settings, please refer to the documentation for each application. In many 
cases the settings will be dependent on the configuration of the network and 
servers. See Launch application on page 24. 

2.5 User Settings 

Behind this icon, the user will find some general settings that can be configured. In 
specific, four type of settings can be defined by the user: 

• General: 

o Auto start: The software will be launched at system boot. 

o Prompt me for Plug and Play devices: The user will be prompted 
whenever a new plug and play device is installed/inserted. 

o Auto scan for networks in active profile: Will scan automatically for 
networks at specified intervals. 

• Connect: 

o Automatically connect on application startup: The Communication 
Centre will connect automatically when application is launched. 

o User Confirmed disconnect/reconnect: The user can defined when 
the Communication Centre will retry to connect. This will let the user 
decide how to handle disconnects/reconnects. 

o Automatically reconnect on lost connection: If the configured 
connections breaks without user intervention (no disconnect from the 
user), then the Communication Centre tries to re-establish the 
connection. The user has the choice between fully automatic re-
connect or user confirmation. Additionally, there are parameters like 
interval and maximum re-connect tries. 

• WLAN: 

o Auto scan for wireless networks: Will invoke the WLAN sniffer at 
specified intervals. 

o Popup dialog when networks are found: When the WLAN sniffer 
has detected a new wireless network the user will be prompted and 
have the possibility to log on to this network. To do a success fully 



Communication Centre Software – User Guide   

 

13

login the correct credentials has to be used. Furthermore, the WLAN 
tab pane contains a configurable time interval to scan for wireless 
networks out in the air. 

• Window: 

o Always on top: Will set the Communication Centre to always stay on 
top. All other windows will be the background.  

o Startup window size: Set the start up mode of the software between 
“expanded”, “toolbar” or “tray icon”.  

 

2.6 Default Devices 

This menu gives the option to specify the default devices that will be used for 
connectivity. For each of the supported bearer types UMTS, GPRS, WLAN and LAN 
the user might define a device that is used to establish a connection. To select a 
default device, choose from the list of devices that are already installed on the 
system. 

From this dialog the user may also reach the ‘Install New Device…’ dialog by a click 
on that button. Clicking the ‘Install New Device…’ button, a dialog comes up that 
guides the user through the installation of device drivers for supported mobile 
terminals and PC cards. Read more on how to install a new device in the Getting 
Started Guide. 

2.7 Import 

It is possible to import configuration settings to the Communication Centre Software. 
You can do that from Import under the File menu. This can be useful for restoring 
default settings, or when new configurations are distributed to users. 

2.8 Export 

It is possible to export configuration settings from the Communication Centre. You 
can do that from Export under the File menu. This is useful for creating and 
distributing settings to other users. You can save the configuration to a file, a 
configuration file, which contains all modified settings made for the software. Choose 
between Full configuration settings export and Task only export, click OK and 
choose the name of the file. The Communication Centre Software  will create an XML 
file that stores the configuration. This file can be copied to a different Laptop and 
there being imported into the Communication Centre Software. Straight after a 
configuration import, the Communication Centre Software on that Laptop will use the 
newly imported configuration and settings. 
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2.9 Restore Configuration 

Restore Configuration may be used if you want to set the Communication Centre 
Software back to the configuration that was pre-configured directly after installation. 

When clicking Restore Configuration, the Communication Centre Software will 
import the configurations from the config_default.xml and config_default.encrypt files. 
These files contain all initial settings and activate them. 
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3 Connections 

You can reach the connections which are available and managed by Communication 
Centre Software via the Configuration entry within the Options menu. Within the 
Configuration window click Connections to open the Connections window. The 
Connections window will open and lists all connections that are available within the 
Communication Centre Software. For security reasons these connections will only be 
available in Microsoft Windows RAS when a connection is established.  

In the Connections window you can: 

• add new connections (Add) 

• configure connections (Properties) 

• delete connections (Delete) 

• import connections (Import…). 

 

3.1 Pre-configured ones 

Communication Centre provides you with 6 pre-configured connections, ready to go 
for Internet Access, using T-Mobile’s UMTS/GPRS  and WLAN HotSpot networks: 

• T-Mobile UMTS (default T-Mobile UMTS Internet connection) 
• T-Mobile GPRS (default T-Mobile GPRS Internet connection) 
• HotSpot (one of three the default public WLAN connections) 
• T-Com HotSpot (one of three the public WLAN connections) 
• T-Mobile HotSpot (one of three the default public WLAN connections) 
• BT Openzone (WLAN Roaming Partner of T-Mobile) 
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3.2 Create New Connections 

You can add new connections to the Communication Centre Software by clicking on 
the Add button, which opens the Create New Connection window.  

 

To add a new connection you have to follow the steps described below. 

1. Define a name for the new connection within the entry field Connection 
name 

2. In the General tab select a Bearer type for the new connection. Following 
bearer types are supported by Communication Centre: 
LAN, WLAN, GPRS, and UMTS. 

3. Optionally, you have the possibility to set usage thresholds on a recurrent 
basis for the new connection within the General tab. You can choose 
between time based (in minute steps) or amount of transferred data (in Kilo 
Byte steps) based thresholds. By default the usage thresholds are setup for a 
monthly basis but you can select the period of the thresholds to be taken in 
consideration by the system by ticking the recurrence box and choosing 
between Daily, Weekly or Monthly basis. In case one of the thresholds has 
been reached you will get a message and can decide whether you further 
want to use this connection for the actual period considered (by default the 
month). For the upcoming new period (by default the next month) the 
threshold counter will be reset automatically and you can start to use your 
connection again.  

4. Configure the settings for your selected bearer type for the new connection by 
clicking on the Settings button. You can find a detailed guide about bearer 
specific settings later in this Chapter.  

5. Optionally, you can choose to use an application for your new connection by 
clicking the Applications tab. This application will be launched automatically 
after the connection was established successfully. Possible applications to be 
launched after connection are: 
Internet browser, Email client, Speedmanager client, VPN client and any 
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executable Custom application. You can find a detailed guide about 
application specific settings later in this Chapter.  

6. Click the OK button in the lower right corner of the Create New Connection 
window and the connection is ready to be used within Communication Centre.  

 

3.3 Configure Connections 

You have the possibility to change the settings for any available connection within 
Communication Centre. To change the settings for an existing connection you must 
select the connection from the list and then press the Properties button. The 
Connection Settings window will open, where you can configure any setting of the 
selected connection. 

  Important Note 
You should be very careful, when you want to configure the settings 
of one of the preconfigured default connections. Changes you make 
will immediately apply and might stop the proper operation of your 
Internet Connections.  

In case your default Internet Connection does not work any more 
after you have made some changes to the connection settings, you 
have the possibility to restore the default setting by clicking on the 
Restore Configuration entry within the Options menu.  

 

3.4 Delete Connections 

You have the possibility to delete any connection from the Communication Centre. 
To delete an existing connection you must select the connection from the list and 
then press the Delete button. The selected connection will be deleted and is no 
longer available within Communication Centre. 

  Important Note 
You should be very careful, when you want to delete one of the 
preconfigured default connections. Changes you make will 
immediately apply and might stop the proper operation of your 
Internet Connections.  

In case you have done a deletion by mistake, you have the 
possibility to restore the preconfigured connections by clicking on 
the Restore Configuration entry within the Options menu.  
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3.5 UMTS/GPRS Specific Settings  

In case you have selected UMTS or GPRS as bearer type for your connection 
following settings are specific: 

1. You have to provide an Access point name within the text entry field in the 
GPRS or respective UMTS tab. The shown picture illustrates the specific 
settings for the GPRS bearer. All pre-configured GPRS Connections in TMCC 
use APN names and settings related to T-Mobile Networks, allowing a ready 
to go Internet connection. In case you want to use a specific Company 
Connection (e.g. from your Mobile IP-VPN), please refer to your IT-
administrator for detailed information regarding the APN. 

 

2. You must select the PDP type, default is IP. You also may select PPP from 
the drop down box. The actual PDP type which you have to select for your 
connection depends on the terminal and the network. Currently, most 
terminals and networks support the IP only. 

3. Optionally, you may choose to use compression for data and/or IP packet 
headers for this connection.  

4. Optionally, you may tick the check box Show modem lights in the General 
tab. In case you have ticked this check boy a connection icon in the windows 
system tray will indicate that the connection has been established. 

5. Optionally, you may tick the check box Disconnect after x idle minutes. In 
case you have ticked this check box, you may define an idle time limit, after 
that the connection will be disconnected automatically.  

  Important Note 
You should be very careful, when you want to change these settings 
for the preconfigured connections. Changes you make will 
immediately apply and might stop the proper operation of your 
Internet Connections.  
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In case you have done a deletion by mistake, you have the 
possibility to restore the preconfigured connections by clicking on 
the Restore Configuration entry within the Options menu.  

 

3.6 WLAN Specific Settings 

In case you have selected WLAN as bearer type for your connection following 
settings are specific: 

1. You must specify the Network name 
(SSID), within the text field next to this 
label in the Association tab. It might 
already be possible to connect to that 
SSID if no encryption and 
authentication is used. Just press OK 
in that case. 
The SSID ‘any’ will apply to any actual 
broadcasted SSID and connects you 
automatically to the Access Point with 
best signal strength. In case you 
specified a SSID other than ‘any’, you 
would only be connected to an Access 
Point broadcasting this specific SSID. 

 

1. Optionally you may use network authentication for a wireless LAN connection 
by activating the Network authentication option in the Association tab. In 
case you have activated network authentication you must select the data 
encryption algorithm. Currently WEP and WPA encryption are supported. 
WEP (Wired Equivalent Privacy) is designed to provide security by encrypting 
the data that is transmitted from Access Point to your WLAN device. Where 
as WPA (Wi-Fi Protected Access) is a combination of an existing 
authentication framework, encryption and message integrity check. WPA will 
most likely be used in medium and large organizations with their existing 
RADIUS servers. 

2. In addition you may define security settings for a wireless LAN connection by 
clicking the Security tab. In the Security tab you may choose a Login 
module to access the service of a wireless internet service provider (WISP). 
Communication Centre Software currently supports the login module 
‘HotSpot’ that you can use in a T-Mobile or T-Com HotSpot. 

3. In the Security tab you may also enable IEEE 802.1x authentication for this 
connection. In that case, your IT-administrator or the WISP will provide you 
with necessary details regarding EAP type and authentication method. 
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3.7 LAN Specific Settings 

By default, the LAN adapter on a laptop is activated and a connection entry in the 
dialup network is configured by MS Windows. In Communication Centre Software, 
there are no specific settings for LAN connections configurable. Instead, click with 
the right mouse button on the LAN adapter (via control panel | dialup network) to 
show and edit the properties. 
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3.8 Settings Common to all Bearer Types 

3.8.1 Internet Protocol 

This tab contains parameter inputs related to the Internet Protocol (IP features). Only 
a brief description is given here; please refer to the Windows Networking & RAS 
documentation or the IP and/or PPP protocol specifications for further details about 
the corresponding input fields. 

Two areas of this tab permit the definition of IP address and DNS server address. 
The latter one is a server on the Internet that maps URLs (web addresses) to IP 
addresses, so that the traffic reaches the correct host, etc. 

The first area provides radio buttons to toggle between obtaining the IP address 
automatically or use a specific IP address. When choosing Use the following IP 
address, the IP address has to be entered in the corresponding text field. If it is set 
to Automatic, no more info is requested. 

The second area uses radio buttons to define DNS server address attribution as 
Automatic or use a specific DNS server address. When choosing Use the following 
DNS server address the user needs to enter the address of the DNS server. 
Preferred address field is mandatory, Alternate address field is optional. If it is set to 
Automatic, no more info is requested. 

3.8.2 Proxy 

By selecting the Use automatic configuration script check box within the Web tab, 
it is possible to automatically configure the proxy server settings. The user must enter 
an URL that links to a server containing a PAC configuration script. This is useful in 
some corporate remote access scenarios. 

If a proxy server is used for the Internet communication, the user has to tick the Use 
a proxy server checkbox and enter the URL or IP address of the proxy server in the 
Address field. A preferred port number can be entered in the Port field. 

If the Bypass proxy server for local address field is ticked then this assures that 
the proxy server does not handle internal addresses. 

The user can also specify what are the exceptions for the use of the proxy server 
(see figure). 
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3.8.3 PPP 

This tab contains input fields related to the PPP features of the connection; see the 
Windows RAS documentation for further details. These options are depending on 
ISP server details and therefore must be configured with the same parameters. 
 

• Selecting Active LCP extensions enables the RAS to use extended Link 
Control Protocol. 

• Selecting Active software compression enables the sending of compressed 
IP packets. 

• Selecting Active header compression enables the sending of compressed 
header packets. 

• Selecting Client for MS network activates the Microsoft Network client (using 
NetBIOS and related protocols) over the connection. This may be useful in 
certain LAN access scenarios. 

• Selecting File and printer sharing for MS network enables the use of remote 
share and/or print on a remote Microsoft Network over the connection. This 
may be useful in certain LAN access scenarios.  
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3.8.4 Security 

The user can choose between common credentials-based authentication protocols: 
PAP, CHAP and MS CHAP, depending on the ISP or corporate network policy. 
These are different protocols for communicating username and password and if the 
wrong protocol is used the logon will fail. 

The Username and Password fields are used to enter the authentication credentials 
to use at connection time. For security reasons, they are encrypted when saved. 

To access public WLAN networks, a Login module may be used to support 
automatic login procedures. The login module “HotSpot” may be used for HotSpots 
provided by T-Mobile, T-Com and roaming partners. Additional login modules might 
be added by a software update to support a broader range of public WLAN networks. 
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4 Launch of Applications 

With Communication Centre Software you are able to define a set of 3rd party 
applications that shall be launched after a connection was established. By doing this, 
you will have i.e. the e-mail client upon a UMTS connection up and running with only 
one click on an application button (resides in the Launchpad). You could even launch 
a set applications upon different events. 

Quick Guide to configure an application to be launched 

1. Click on the menu Options | Configuration. Then go into the Connections 
details and select the connection of your choice. Next click on Properties and 
select Applications to get the Connection Settings dialog.  

 

2. Within that dialog you should click on Add to define any other application that 
you would like to be launched after connection was established. It is possible 
to launch any kind of application, but some application types - supported in a 
more convenient way - are pre-configured and selectable 
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4.1 Internet Browser 

Use this type of application to start an Internet browser upon connecting. It is 
possible to set a default address in the Default URL field that the browser shall start 
with. 

4.2 Email Client 

A launch of the default e-mail client starts the e-mail client that is set to be the default 
one via Microsoft Windows OS. Use this type of application to launch your e-mail 
client after having established an internet connection. 

4.3 Custom Application 

This type of application is used to start any application. Just set the Application path 
to the .exe file of the application and this application will be launched after a 
connection was established. In the Application parameters field you may put in any 
extra parameters needed for the application to suite your individual needs. 

The option for Stop at disconnect may be used for applications that can be closed 
by command line parameters. There you have to define the application path and 
parameters again. It is not possible to exit a program just by defining the application 
path, but you could start an application at disconnect of course. 
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4.4 VPN Client 

If you want to launch a VPN client with Communication Centre Software, you will 
have to define it either as a custom application or – in case of Cisco Systems VPN 
Client – use the VPN client application type. In the latter case Communication 
Centre handles the tasks to establish and terminate a VPN tunnel. 

The configuration of VPN clients is not part of this manual. If you want to use a VPN 
client together with the Communication Centre Software, you must define a VPN 
profile with server settings, certificates, algorithms, etc. in the VPN client. Please 
make sure that you have the correct configuration to fit the VPN-gateway settings to 
connect to your corporate network. 

 

  Important Note 
Communication Centre Software supports VPN clients related to 
starting the client and to establish or terminate a VPN tunnel with a 
given VPN profile name and user credentials. 

The status of an established VPN tunnel is not monitored by the 
Communication Centre Software. You must use the VPN clients user 
interface to monitor the tunnel status. 

Communication Centre Software does not keep track of the tunnel 
status and will not warn you if the tunnel was terminated for 
whatever reason. 
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5 Tools and further Features 

5.1 WLAN Sniffer 

 

The WLAN Sniffer is used to scan the 
local area for available networks. Any 
wireless network found will be listed by 
SSID, connection, type and signal 
strength. From this list it is possible to 
select a wireless network and directly 
Connect to. 

Click on Configure to define this 
wireless network as one of your 
preferred connections into the list of 
Connections. Once you have 
configured a connection, this 
connection will be listed in the 
“Preferred networks” list view.  

With the Refresh button you are able 
to update the list of available wireless networks that are currently up in the air. 
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5.2 HotSpot Locator 

The Communication Centre Software contains a tool that you will use while travelling 
and looking out for the nearest available HotSpot. The HotSpot Locator is a client 
with a small footprint database containing detailed information of available HotSpots, 
i.e. location details, type of category, the opening hours. 

With the HotSpot Locator you can search for Hotspots in any country where public 
HotSpots are operated by T-Mobile and T-Com i.e. in locations like hotels, coffee 
bars, airports and other business lounges. 

You are able to launch the HotSpot Locator by clicking on the Tools | HotSpot menu 
and then click on HotSpot Locator. Afterwards the Locator dialog will come up with 
the start screen that displays quick search criteria to look out for available HotSpots. 

 

 

 

 

In the Quick Search 
view you are able to 
define a country, 
the city together 
with a category like 
Café, Hotel, Airport 
and furthermore a 
perimeter of 2, 5, 10 
or 20km by which 
the search shall be 
narrowed by. 

 

If you click on the 
Search button, a 
dialog will come up 
to present the 
search results with 
all relevant 
information of the 
found HotSpots. 
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5.3 SMS Center 

The Communication Centre is equipped with an SMS application. To start to use the 
SMS application, click the Tools menu and choose SMS Center. From the SMS 
Center you can send and receive messages as well as Import/Export/Edit contacts 
between Communication Centre and the SIM-card. 

  Important Note 
To send and receive SMS’s, the PC has to be attached to the UMTS/ GSM 
network. If the PC is connected most devices cannot send or receive SMS. If 
the Operator name and Signal Strength is indicated in the Communication 
Centre and if the Status Display says, “not connected”, the PC is attached. 
If the Status Display says “connected” the PC is connected and most devices 
will not be able to send/ receive SMS. 
SMS sent when connected will be saved in the outbox folder and 
automatically sent, the next time you are attached to UMTS and GPRS. 

 

The File menu lets you import/export contacts and the Tools menu lets you edit 
settings for the SMS application. Normally, the SMS application reads all needed 
parameters from the SIM card. It is therefore advised, not to change any settings 
unless there is a clear reason for doing so. 

SMS Quick Guide 

To create and send a new SMS:  

1. Click the Write new SMS button. 

2. Write the message in the Message field 

3. Type in the phone number of the receiver (one or multiple) of the 
message, in the Phone Number field or double-click the receiver in 
the Contacts list field. 

4. Click the Send button. 

5. The message is stored temporary in the Outbox folder and then 
automatically moved to the Sent Items folder. 
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In order to ensure the ease of use of the SMS application there are separate folders 
for the: 

• Contacts 

- To Import and Export contacts, choose the File menu and then Import / 
From SIM card or Export / To SIM card.  

- You can edit and delete contacts from the Contacts list by using the 
related buttons for this located below the Contact List field, Edit and 
Delete. 

- To add a new contact, click the New button located below the New 
Contacts field. The type in the name and phone number in the New 
Contact field and click Save. 

 

• Drafts 

- When creating a new a message by clicking the Write New SMS button it 
is possible to click the Save button below the ‘Message’ window, the 
message will then be stored in the Drafts folder. 

- You can at any time delete messages stored in the Drafts folder by 
highlighting the message to be deleted by clicking Delete 

- To send a message from the Drafts folder, simply highlight the message 
in the ‘Drafts list’ and click the Edit button below the ‘Message’ window. 
The same screen as seen when clicking ‘Write New SMS’ will be viewed, 
click send to send the SMS. Alternatively, double-click any message from 
the Drafts list to be displayed on screen. 
 

• Inbox 

The Inbox folder contains all received messages. 

- Delete a message from the Inbox by highlighting the message and click 
the Delete button. 

- Click the Add to Contacts button to add the phone number and name of 
the sender of the received message, to the Contacts folder list. 

- You can reply and forward messages by highlighting the message and 
then click the Reply or Forward. 

 

• Outbox 

The Outbox folder temporarily stores sent messages. If of any reason the SMS 
could not be sent, the message will be stored here until it can be sent. 
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- To delete a message from the Outbox list, highlight the message and click the 
Delete button. 

- To edit a message before it is sent, highlight the message and click the Edit 
button. Then you will be displayed the ‘Write New SMS’ screen that lets you 
edit and re-send the message. 

 

• Sent Items 

The Sent Items folder stores sent messages until you deletes them. 

- To delete a message, highlight the message in the Sent Items list and click 
the Delete button. 

- You can also edit a sent message and have it sent again. Simply highlight the 
message in the Sent Items list and click the Edit button. You will then be 
displayed the ‘Write New SMS’ screen that lets you edit and re-send the 
message. 

5.4 Usage Monitor 

The Usage Monitor is 
for you to view current 
and retrieve history 
information on a 
connection level. The 
report of how much 
data has been 
transferred on a 
connection or how 
much time you have 
been online might help 
you to analyse your 
specific usage 
behaviour. It will also 
give you an overview 
on how much data you 
transfer per month. 

You can switch from 
data to online-time 
based view by using 
the Time button on the 
lower left. Switch back 
to data view with the 
Data button. 

With the top left drop down menu you can select on what data/time out of the pre-
configured connections shall be displayed. 
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In the Configuration of Communication Centre you will be able to define a volume 
limit on a connection and limit your own data throughput. Especially when using data 
volume tariffs this will give you a hint on what volume is used up. 

  Important Note 
The data that is displayed in the Usage Monitor is not billing relevant and 
might differ from the transferred data volume that you will find on the phone 
bill from your mobile network provider. 
The data displayed in the Usage Monitor should be used for trend and 
personal usage analysis only. 

You can choose from different time bases for the report. The options are: 

1. Today 

2. Actual week 

3. Last 7 Days 

4. Actual Month 

5. Previous Month 

As long as you are connected with whatever connection, the Usage Monitor will 
display only the current connection information. While connected it is not possible to 
analyze historic information.. 

 

5.4.1 Current session 

The Communication Centre Software displays a continuously scrolling graph showing 
data rate of the last 50 seconds. The data rate is calculated as the real-time sliding 
average over 5 seconds for the currently connected Connection. The information is 
displayed with numbers for current average data rate or the amount of data 
transferred since the start of the session. Both Uplink and downlink are displayed. 

5.4.2 Historical data 

The Communication Centre displays historical data in a graph showing the selected 
information. The X-axis represents time in days; the Y-axis represents data volume 
(the sum of transmitted and received data) in kilobytes or session time in minutes. 

Session information belongs to the start day of the session. If there are more than 
one session for a day the values for the sessions are added. 

The user has the option to reset the statistical data counters. If reset is chosen all 
historical information will be deleted. The data for the current session is not affected. 
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5.5 Set Password 

This allows the user or an IT administrator to set and change the password in order 
to reach the Configuration. An option to enable and disable the password lock is 
also available. 

 

 

5.6 Restore Configuration 

In the Configuration of the Communication Centre there is an extended form of 
Restore Configuration. If you choose the menu Options | Configuration and then 
click on Restore Configuration, you will get the following dialog: 
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With that feature it is possible to save a configuration as a restore point. When a new 
restore point is created, a snapshot of the current settings will be stored so that the 
configuration can be restored at any time later. It is possible to create several restore 
points that allows you to go back to some historical settings if you want to. 

To import a Restore point into the Communication Centre, highlight the Restore point 
and click Restore.  
Click Restore Default to set the Communication Centre back to the configuration 
that has been pre-configured direct after the installation. The default restore file 
contains all initial settings. 

 

5.7 Software / Firmware Update 

During the installation procedure of Communication Centre an update agent is 
installed on the PC. The update agent runs in the background as a separate 
application. 

The automatic update agent runs automatically at start-up of the PC. It is capable of 
detecting any available new version of Communication Centre software, drivers and 
configuration files and informs you that an update is available. 

Periodically, initially set to every 14th day, the update agent connects to a server 
using FTP over the network connection available from the PC. Every time this is 
done the update agent checks on the server whether new updates are available or 
not. If there is you will be prompted whether to download and install the updates or 
not. 
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5.7.1 Software Update 

 

When clicking Automatically download updates and notify me, all the new files 
will be silent selected and downloaded. The next time you click “Software Update” 
the new files can be installed. 

If you choose to download and install a set of Updates the following dialog will be 
shown 

You are now able to choose which files to download and install. Some files are 
probably set to mandatory in the list. These files will not be possible to deselect. 

When clicking the Snooze button, the Update dialog will disappear and pop-up after 
the defined time indicated in the Click Snooze to re-check in field has elapsed. 

When clicking Select All, all the new Updates will be selected to download. Click OK 
to download and install the Updates. 

When new Updates have been successfully downloaded and installed, a dialog will 
be displayed to inform you that the Update has been performed. 

  Important Note 
Automatic update agent uses FTP for downloads. It is therefore 
important that port 21 is opened in any firewall that this traffic has 
to pass through. In case of problems with downloads, contact the 
IT-administrator. 
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5.7.2 Firmware Update 

T-Mobile is constantly improving its network and services in order to offer its 
customers the best network possible. In this context, T-Mobile has upgraded its 
UMTS Network to support HSDPA (High-Speed Download Packet Access), the last 
development in terms of High Speed connections. 

To benefit from this high speed technology, an user needs in addition of the present 
Communication Centre to use one of the following new released data cards: 

1. Mobile DSL Card* or Mobile Broadband Card* 
 

2. Mobile DSL Card WLAN* or Mobile Broadband Card WLAN* 

*: The name of the card may differ depending on your national T-Mobile operator. 

The user of the above mentioned data cards will always need the last version of the 
cards firmware to fully benefit of the High-Speed-3G technology. The Communication 
Centre is detecting automatically which version of firmware is installed for the card 
used and will prompt when necessary the Firmware Update. 

 

5.8 Flight Mode 

The Communication Centre includes now an option which enables the flight mode 
the same it works already with mobile phones. 

The flight mode consists in switching off all radio activity of the currently used data 
card. This is particularly useful when the user is in an area where it is required to 
switch off all radio activity (plane, hospital…) and doesn’t want to take off the card 
from his laptop. 

To enable the flight mode, click on the Options menu and select Flight mode. 

  Important Note 
Some data cards don’t support the Flight Mode functionality. 
The Communication Centre will detect if this functionality is supported or not 
by the data card in use. If Flight Mode is not supported by the data card, the 
menu item “Flight Mode” will be then greyed out and it won’t be possible for 
the user to select this option. 
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6 GPRS/UMTS Device Settings 

6.1 PIN Management 

The Communication Centre can be used to 
change the PIN code on the SIM card that is 
plugged into the default device. It is also 
possible to enable and disable the PIN Code 
security check. Choose PIN Management out 
of the Options | GPRS/UMTS Devices menu 
to define a new PIN code or de-activate the 
PIN code request. 

Once you have configured to use the PIN 
code security check, each time the device 
with that SIM card is plugged in, 
Communication Centre will prompt you to type 
in the PIN code before you can use that SIM card for connectivity. 

 

6.2 Network Selection 

The manual network selection allows you to change the network operator that is used 
to establish a connection. In the same way as it done with any other mobile terminal 
while being abroad. Normally, the PC card as well as mobile terminals will attach to a 
preferred network in this case. But for a good reason you might want to switch to 
another operator that supports roaming with your SIM card. 

The Communication Centre will list the networks that are available due to roaming 
agreements between the mobile network operators. For more information on roaming 
agreements in foreign countries and maps of the networks please contact your 
mobile operator. 

6.3 Frequency Band 

With the feature to select the frequency band you are able to set the frequency that is 
to used by the device. This functionality is device dependent and will only work with 
data cards or mobile terminals that support different frequency bands. Check your 
device specification or contact your mobile operator for detailed information. 

You will get the Frequency Band dialog by clicking on the Options | GPRS/UMTS 
Devices menu. 
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7 Appendix 

7.1 TCP/IP settings 

The TCP/IP settings into the Windows Registry of the computer have been modified 
by the Communication Centre during its installation in order to give the user the best 
and most optimized performance possible for all bearers.  

The following registry key was added in order to provide mobile broadband access 
with best performance: 

\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\ 
                       Services\Tcpip\Parameters\TcpWindowSize 

The TcpWindowSize key/value pair is set as follows: 

TcpWindowSize    REG_DWORD    0x0000800c (32780) 

 

If you don’t want to adopt these changes, you can delete the TcpWindowSize registry 
key and you will get back to MS Windows default settings. 
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7.2 Redistributable 

If the user selects the Deployment installation type during Installation of the 
Communication Centre, two additional features will be proposed to the IT-
administrator. 

First of all, during installation, the user will be prompted with an interface allowing him 
to choose a specific Access Point Name (APN) for the connections. 

Second, an additional option will be installed in the Start Programs menu and will 
allow an IT administrator to create a re-distributable installer file with some 
customized options. 

 

7.2.1 Installation Wizard 

To create a re-distributable installer of the Communication Centre, click the Windows 
‘start’ button and locate ‘T-Mobile’ under the ‘programs’ tab and select the ’create 
redistributable installer’ program. 

 

The Redistributable installation wizard will allow the user to create setup version with 
the parameters he has selected. 
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By default all features, modules and drivers are selected. 

If the IT-administrator wants to create an installer without one of the features, 
modules or data cards drivers, he simply needs to deselect (un tick) the check box in 
front of the option he doesn’t want. 

Then it is possible to specify the directory where the setup version with the right 
parameters will be saved. 

Click on Create Installer and the version is automatically  create and ready for use 
and redistribution across all users. 

7.3 Email Wizard 

The Communication Centre includes an e-mail wizard that helps you to configure e-
mail accounts on the default e-mail client.  

The Email Wizard is started through the Start -> Programs -> T-Mobile shortcut. 

 

The prerequisites are that you have to have a POP3  e-mail account at one of the 
providers in the list. To create an account, you need to select the type of account 
from the list of providers and enter the following information: 

1. Account Name 

2. First Name  

3. Last Name  

4. e-mail address 
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Within the same session, you can create another account by ticking “I want to create 
another e-mail account” and click on Finish otherwise click on Cancel. 

 

When you click on Finish, the Email Wizard modifies the default e-mail client settings 
and adds the account with the user details. To modify the details or remove an 
account, please refer to the e-mail clients documentation. 

  Important Note 
Your email provider must be in the list for the email wizard to work. 

You can check which e-mail client is the default one on the PC from the Control 
Panel. Simply select Internet options - the programs tab shows a list of programs 
associated to email. 
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8 Troubleshooting 

8.1 Common Troubleshooting Procedures  
• Isolate the problem to one component, layer or stage of the connection 

process. This will allow a fine-tuning of troubleshooting techniques and tools 

• Always determine whether a problem is reproducible or not, i.e. have the user 
retry, and make sure they get the same error or symptom, at least once. 

• Have you ever connected successfully? Has this ever worked? If so, what has 
changed? 

• Always reboot both the PC at least once, before going into deep 
troubleshooting procedures. This should be repeated, if a major change is 
made yet the connection still fails. 

• Always get the Trace log or exact error message, as well as the environment 
details. The details required will differ, depending on where the problem lies. 

 

Communication Centre uses a trace file, stored in txt format on the hard disk under 
Documents and Settings -> <User> -> Application Data. The logfile.txt contains 
install details, and some per session information. The original file is appended to at 
each new session, and when the file is over 1 Mb, a backup is created 
(logfile_old.txt) and the file reset. 

8.2 Communication Centre Error Messages 

Note: Communication Centre may report errors both from its own internal error list as 
well as via API, e.g. Microsoft Windows RAS generated errors. This document lists 
common errors and troubleshooting suggestions for these. 

8.2.1 Error: The AT command is not supported 

Cause: This indicates that that the subscriber is outside the UMTS/GPRS coverage 
area, does not have a UMTS/GPRS subscription or that the selected Modem does 
not support UMTS/GPRS. 

Troubleshooting: 

• Check the UMTS/GPRS device is connected to the specified port and is 
powered on. Also check that the device indicates UMTS/GPRS coverage.  

• Ensure that the user is actually subscribed to the UMTS/GPRS service, for 
the SIM in use. (note: this is most likely cause of the error!) 
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• Ensure that the customer is in an area of UMTS/GPRS coverage. Consult the 
device manual for details on how to check this. 

• Check the correct modem/device driver has been set as the default modem or 
selected for the profile. If the user has several modems installed, he or she 
may mistakenly select the wrong modem (e.g. non UMTS/GPRS) for the 
connection. 

Additional Details: All communications between PC and modem required to set up 
a connection take the form of AT commands. The AT commands are stored in the 
modem driver (.inf file) and in a configuration file that Communication Centre utilizes. 
Different modem vendors may support different commands, although in general most 
vendors will support a common subset of commands depending on the type of 
modem (e.g. V.90 , ISDN TA ,UMTS/GPRS specific commands etc). 

UMTS/GPRS connections also require a specific subset of the AT commands. The 
error above indicates that the AT commands sent by the application has not been 
understood by the terminal. 

The error could also indicate an error with the modem driver, and the AT command 
syntax that it uses. The source of the modem driver should be investigated in this 
case. Please eliminate the above possibilities first though. 

 

8.2.2 Error: Communication port opening has failed: can't open 
the serial port, The system cannot find the file specified. 

Cause: Incorrect or missing COM-port/modem driver chosen. 

Troubleshooting: 

• Make sure that the modem that the user tries to use really exists as an entry 
in Windows ‘Modem Properties’ and that it’s connected to the correct COM 
port. 

• Reinstall modem on the correct COM port, and select the correct modem for 
the connection. 

Additional Details: Selected COM port for modem drivers can be checked from the 
Modem Properties dialog in the Control Panel of Windows.   
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8.2.3 Error: Communication error when accessing mobile name 

Cause: The device is not responding properly to the CGMM/CGMI command 
(manufacturer and model of the device). TMCC interprets this as a communication 
error. 

Troubleshooting: 

• Restart device.  

• Upgrade device firmware. 

Additional Details: Sometimes it helps to restart the device and try again (may have to do 
this more than once). If this does not work, the user should upgrade the device with the latest 
firmware. 

 

8.2.4 Error : Communication error when sending the ATTACH 
command: failed to read on serial port, Serial time-out has 
expired 

Troubleshooting: 

• Restart the device. 

• Choose another driver for the connection. 

• Upgrade device with the latest software. 

 

8.2.5 UMTS/GPRS – Check the Modem settings in the PC 
settings control panel to confirm the modem type and 
properties are correct. 

Cause: Usually means that modem type or settings are invalid as seen by the 
operating system. 

Troubleshooting: 

• Check that the correct modem is used by the connection.  

• Check Modem Properties. 

• Uninstall the current modem driver used, and reinstall the correct driver. 
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8.2.6 ERROR : 720 - The connection attempt failed because 
your computer and the remote computer could not agree 
on PPP control parameters. 

Cause: The device is not able to negotiate PPP parameters. There can be multiple 
causes of this error message. 

Troubleshooting: 

• Make sure the customer turns off and on the device before retesting. 

• Check the configuration of the connection profile. Check APN, 
username/password, PPP/IP settings.     

 

8.2.7 UMTS/GPRS: Disconnected, 
ERROR_PPP_NO_PROTOCOLS_CONFIGURED 

Cause: The device is not able to negotiate PPP parameters. The APN Name is 
incorrect. Typical reason: APN is incorrect 

Troubleshooting: 

• Has a UMTS/GPRS connection ever worked for this customer from this PC, 
with this device? 

• Make sure that you reboot both the PC and the device before testing. 

• Check the configuration of the connection. Check APN, username/password, 
PPP/IP settings.     

 

8.2.8 ERROR : 718 - Timed out waiting for a valid response 
from the remote PPP peer. 

Cause: The device is not responding properly or fails to respond to commands sent 
by the software 

Troubleshooting: 

• Reset the device and reattempt the connection 
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8.2.9 Error: Communication error with modem: failed to read on 
serial port, Serial time-out has expired 

Cause: The software is not able to communicate with the device as expected. 
Typically this is because the COM port is occupied by another software, such as 
Active Sync, HotSync etc. The error could also be caused by a hardware error on the 
device attached to the COM port. 

Troubleshooting: 

• Make sure no third party software is blocking the port. Often it helps just to 
wait a while, let the communication on the port end. If this does not help, first 
reset the device and ultimately also the laptop.  

 

8.2.10 ERROR: 734 - The PPP link control protocol was 
terminated. 

Cause: The network disconnects the UMTS/GPRS session due to faulty parameters 
(e.g. APN name) being sent.  If the user logged on to the PC does not have 
administrative rights, the Operating System prevents the APN name from being set, 
and this error is observed on connection. 

Troubleshooting: 

• Check APN-name (case sensitive) and other configuration options. 

• Enter the APN name directly in the Modem Properties / Advanced/ Extra 
settings.  (Administrative Rights are required on the PC) 

• e.g. AT+CGDCONT=1,"IP","APN","",0,0 (replace APN with the correct name) 

• Reset the device/laptop. Upgrade the device with the latest firmware. 

 

8.2.11  Error: Communication port opening has failed: can't open 
the serial port, The specified network name is no longer 
available. 

Cause: There can be multiple causes of this error message, but the most common 
one is that the modem driver selected from Communication Centre is corrupt or does 
not exist on the system. 



Communication Centre Software – User Guide   

 

47

Troubleshooting: 

• Check that the modem exists under ‘Modem Properties’ in the Control Panel 
and is in fact the one used/selected from Communication Centre. 

• If necessary reinstall the modem and then select it from Communication 
Centre 

Additional Details: In some cases, a plug ’n’ play installed IR-modem may override a 
manually installed, already existing, modem of the same kind. In the modem list in 
Communication Centre, the old modem will still be visible until next reboot. This modem entry 
will not work and selecting it may cause the above error message to be displayed. 

 

8.2.12 Your operator did not license this software 

Cause: This error means that the user is trying to use the software in another 
operator’s network (ie with a SIM card that does not belong to T-Mobile).  
Communication Centre is designed to prohibit such a connection. 

Troubleshooting:  

• If using a T-Mobile SIM, restart the device and reattempt the connection, also 
check wilog.txt trace. 

• Contact T-Mobile Support for details. 

8.3  Summary of some useful Troubleshooting Tools 

8.3.1 Freeware Tools 

Mark Russinovich and Bryce Cogswell provide a bunch of useful freeware tools, 
downloadable from their website: http://www.sysinternals.com 

Following tools are useful for troubleshooting: 

PortMon: a monitoring tool for all serial and parallel port activity. It has advanced 
filtering and search capabilities that make it a powerful tool for exploring the 
communication on the port.  

FileMon:  monitors and displays file system activity on a system in real-time. s. 

TDIMon: is an application that lets you monitor TCP and UDP activity on your local 
system. It is the most powerful tool available for tracking down network-related 
configuration problems and analyzing application network usage. 
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Regmon: is a Registry monitoring utility that will show you which applications are 
accessing your Registry, which keys they are accessing, and the Registry data that 
they are reading and writing - all in real-time.  

This is just a short collection. More tools can be found on the website. 

There are also a good tools available for real time file viewing:  

BareTail: is a real-time file viewing utility. Like the Unix tail -f utility, it can be used to 
view the end of a growing file. It can be downloaded from: http://www.baretail.com 

This tool can be used with the Communication Centre logfile.txt and wilog.txt for 
real time monitoring.  

 

8.3.2 Microsoft tools 

Mircrosoft Windows provides an integrated Modem Diagnostics and log generator. 
You can reach this functionality by following the steps below: 

• Connect the modem to the PC. 

• Make sure that Communication Centre is not running. 

• Choose  Settings / Control Panel / Modem.  

• Choose the modem giving problems, Properties / diagnostics. 

Here you can either  

• “Query Modem” – immediately returns the software version of phone and 
diagnostics. 

• “Enable Logging” -  check the box to append modem data to a log.  You then 
need to attempt a connection, then return to “View log”. 

Microsoft also provides information about “How TO Enable PPP Logging in Windows” 
in their support web site: 

Win 2k:  http://support.microsoft.com/default.aspx?scid=kb;en-us;Q234014 

Win NT: http://support.microsoft.com/default.aspx?scid=kb;en-us;Q115929 

Others: http://support.microsoft.com/default.aspx?scid=kb;en-us;Q156435 
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8.3.3 Layer 3 (tracing) tools: 

Microsoft Windows command line interface also provides some useful tool for Layer 
3 traing. 

ipconfig /all   - useful to view client IP address, and DNS details assigned.  

Win 98:  instead, run winipcfg /all   

ping    (the address of a reliable node on the network, to check the network 
connectivity).  Note: Some Networks and hosts will block or not respond to Ping. 

Usage: ping [-t] [-a] [-n count] [-l size] [-f] [-i TTL] [-v TOS] 

            [-r count] [-s count] [[-j host-list] | [-k host-list]] 

            [-w timeout] destination-list 

tracert   (if address not reachable by ping, you may see which network node causes 
problem using this utility) 

Usage: tracert [-d] [-h maximum_hops] [-j host-list] [-w timeout] target_name 

nslookup   usefull to find IP addresses for domain names 

 

8.4 UMTS/GPRS Troubleshooting 

It’s often a good idea to test the connection with a Windows Dial-up networking 
(DUN) profile. If the same problem occurs here, it is very likely that the problem is not 
directly related to Communication Centre, but to the hardware or Windows RAS 
software.  

Also, it is a good idea to test the connection with different modem drivers. It’s always 
possible to install a Windows ‘standard modem driver’ from the Modem Properties 
dialog in the Control Panel and then use this modem from Communication Centre. 

8.4.1 How to make a MS Dialup Networking connection: 

The example below is for Windows 2k, each OS will have a slightly different naming 
convention, but the process is in the main, the same. 
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First make a connection attempt using Communication Centre and the terminal 
causing problems. You will reuse some of the parameters from the trace log. 

Within the trace file Wilog.txt use search to fing MobileSettings and MobCom. 
Seetings you should look for are:  

[00000714 17:00:20:069, MobileSettings  ,   50] - loaded PhoneNumber 
command from NOKIA  :D211 : *99***10# 

[00000714 17:00:19:709, MobCom          ,  103] - send command : 
AT+CGDCONT=10,"IP","","",0,0 

bold   - this is the info which should be extracted, and reused with RAS 

italics – ignore, this is both time and phone dependant. 

For the example above you should remember: 

• dial number: *99***10# 

• modem command: AT+CGDCONT=10,"IP","","",0,0 

Then create a new dial up connection from:  
Start Menu / Settings / Network and Dialup Networking / Make a new Connection. 

• Choose “Dialup to Private Network” (this is the simplest and quickest to 
setup). 

• Choose the same modem driver as is used with Communication Centre 
(select only one). 

• Enter the Phone number:  *99***10# 

• Continue to choose default options, until a new DUN connection is made. 

• Now, enable a UMTS/GPRS connection direct from the modem: 

• Start Menu / Settings / Control Panel / Phone and Modem Options 

• Under modems, select the modem that has been chosen above. 

• Choose Properties / Advanced / Extra Settings. 

• Add the following: 

• AT+CGDCONT=10,"IP","","",0,0 
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Now make a connection using the Dialup Networking entry created above, using the 
username and password used. 

 

8.4.2 Troubleshooting the GPRS PC-card from T-Mobile  

Check the SIM is inserted in the card 

Check the correct PIN code has been entered - if the PIN is entered incorrectly the 
user is prompted to enter again (up to 3 times, after which the SIM is locked, 
requiring PUK to enable) 

On the PC:  

• Default Modem should be set to: WCM Modem (GSM). 

• Check Settings / Control Panel / System / Hardware / Device Manager / Ports 
/ WCM *.*  

• Check Settings / Control Panel / System / Hardware / Device Manager / 
Modems / WCM Modem (GSM) for any error messages or hardware conflicts. 

 

8.4.2.1 WIRELESS LAN TROUBLESHOOTING 

Verify that the Wireless Network card is properly installed, and that the 
manufacturer’s drivers and firmware for the card installed. Make sure that the card is 
inserted fully in the PC, and that the adapter is "Enabled" by the operating system. 

For the proper function of the WLAN module within Communication Centre the 
Odyssee software has to be installed properly and the service has to be bound to 
your WLAN card. You can verify this by:  

• Right click the tray icon for the WLAN connection 

• Select “View available networks” 

• Select advanced 

• Select the tab “General” 

• Check whether there is an entry for “Odyssee Network Services” and whether 
the checkbox is ticked. 
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o In case the “Odyssee Network Services” is not available go to 
Windows/downloaded installations and install Odyssee 

o In case the check box is not a ticked, check it 

o Note: Unticking the checkbox before “Odyssee Network Services”, will 
give full control of the WLANcard to Microsoft Windows. This is useful 
for checking the proper installation and configuration of the WLAN 
card. 

If the above fails, and there is no problem with the Access Point check for hardware 
and software issues at the client: 

• Does the OS recognize the PC Card - Check Control Panel / System / Device 
Manager. 

• Are there any IRQ or other resource conflicts? 

• Check there is enough power to the laptop computer, as the PC Card is not 
powered independently. 

• Check that the card is inserted with the correct side facing up. 

• Check the PC card connector for any problems, like bent pins or blocked 
connectors. 

• Insert the card into another slot of the PC (if available). 

• Install the card in another computer. 

• Install a different card in the computer. 

 

8.4.3 SMS 

For problems sending/receiving SMS messages: 

• Check the SMS recipient's phone number. 

• Check the SMS Service Centre Settings under Tools/SMS Settings. 

• Resend the message, this time checking the option "Request status report" in 
SMS Settings. 

• Increase the message validity duration. 
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By default, the service center used is as defined on the SIM card in the device or PC 
card. It is also possible to enter a new Service Center via the GUI. 

Typical Settings on the SIM include: 

(Recommended values are marked with *) 

Msg. centre in use: Depends on the network operator 

Receive report:  

Message validity: 

Long Messages: *ON 

Message sent as: *Text   (Fax/Paging/E-mail not supported) 

Preferred connection: *GSM      (or UMTS/GPRS ) 

 

8.4.4 Troubleshooting IP/DNS assignment: 

Data Transfer/Surfing problems 

In a UMTS/GPRS network, the T-Mobile Connection Center software enables IP 
connectivity using a telephone or PC Card modem device (fixed or mobile).  A 
“network adapter”, called the “PPP adapter”, is enabled on the PC and upon 
connection is assigned an IP address, DNS server address(es) by the network.  This 
network adapter can be monitored, to see the relevant IP information, just like any 
other e.g. Ethernet LAN adapter. In addition T-Mobile Communication Centre also 
enables automatic launch of the users default Web browser to open a pre-defined 
web URL, and integrated session management for e-mail. 

In a Wireless Lan environment, the T-Mobile Connection Center software uses a 
network adapter whose name is not generic but rather dependant on which adapter 
is installed on the PC. 

If the Layer 2 connection is successful (ie the connection is successful), but the user 
cannot surf or send/receive e-mails then check the following: 

• Check for possible incompatibility of PPP/IP settings with the Network 
(UMTS/GPRS/GSM only).  See Troubleshooting PPP/IP settings. 

• Check  for possible IP address/DNS related problems. 

• Check the version of web browser installed, on the PC, it should be Microsoft 
Internet Explorer 5.5 or above. 
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Troubleshooting PPP/IP settings: 

For the profile in use, change the Connection parameters in the following locations, 
to uncheck all PPP and IP compression options. 

• Connection / PPP tab 

• Connection / UMTS/GPRS tab 

Now retest the connection and attempt to surf. 

Troubleshooting IP/DNS assignment: 

A DNS (Domain Name Server) translates a resource name that is easy for a user to 
remember e.g http://www.t-mobile.com into an IP address, which is required to reach 
the resource.  It is possible to bypass the requirement for DNS, by entering directly 
the IP address to the resource. 

Symptom:  The modem connection succeeds, but the user is unable to surf/access 
e-mail etc. 

To Confirm IP-connectivity:  

From the browser, enter the IP address of a well-known web address or host using 
an IP address rather than the domain name.  If this works, then the IP connectivity is 
ok, but a DNS server has not been assigned, or is not functioning. 

Useful system info can be retrieved using the winipcfg or ipconfig from the command 
prompt, note the connection must be established to observe the correct adapter 
information: 

Windows 2k, Windows XP, Windows 98SE: 

• From the “Start” Menu choose “Run” and enter “cmd” or “command” 

• In the “Dos box” that is opened type ipconfig /all   

• Note: The information of interest is under  ‘PPP adapter’ 

Win 98SE 

• From the “Start” Menu choose “Run” and enter “command” 

• Type winipcfg /all  (Look at the displayed info under ‘PPP adapter’) 
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NOTE: the above addresses are listed for illustration purposes only!  Each network 
will have a different set of assignable IP addresses as well as DNS addresses.   

There will typically be more than one Network adapter installed on the Laptop.   

First look for the PPP adapter – if this is not present, then the connection has been 
dropped, reconnect and rerun ipconfig /all 

If Wireless LAN, the adapter is always present, if the software for the adapter has 
been correctly installed. 

Then check that an IP address has been assigned to the adapter. In the example 
above, it is correctly assigned:  10.144.1.192 

Then check that at least one DNS Server is assigned. In the above example it can be 
see that the addresses 10.0.0.1 and 10.0.0.2 are correctly assigned. 

Note: it is also possible to copy and paste information from the command window, by 
selecting the Edit options from the dropdown menu available by clicking on the upper 
left icon.  This information can be paste e.g. to notepad, and forwarded to support. 
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If the IP address is assigned correctly, but there is no DNS address, this may be 
assigned statically via Communication Centre. 

If neither IP address nor DNS address is assigned then you may need to contact 
your Network Administration department check that the Radius or DHCP server 
serving the GGSN/Access Point to which the customer is attached is functional. 

If both the IP address and the DNS address are assigned then: 

Check both addresses are accurate and routable in your network. 

Check for problems with NAT (Network Address Translation). NAT is often used on a 
server by companies that let their employees surf the Internet using only one IP 
address and that directs traffic through this server, though each user has their own IP 
address locally on the Intranet. 

Lastly, there may be a routing problem from the GGSN or Access Point to which the 
customer is attached, so again check with the network administration department.
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Frequently Asked Questions (FAQ) 

 

Question Answer 

What should I do if 
I change my 
UMTS/GPRS 
Terminal? 
  

The majority of Communication Centre settings remain the same, however you may need to 
install the modem, if it is not available under Communication Centre already. 

You need administrator privileges on your PC to run the Modem Setup dialog. Contact your PC 
system administrator. 

Start Communication Centre.  

Select Configuration / Miscellaneous / Default UMTS/GPRS Modem   

Select Install new device… 

In the right hand drop-down menu select the interface.   

Then in the right hand menu you can select the new device. 

Alternatively if you use this new modem only occasionally in addition to your existing modem,
you can dynamically select it in a specific profile. 

Do I need 
administrator 
privileges to 
install ? 
  

Yes, you need local administrator privileges on your PC to run the installer package and
subsequently to run the Modem Setup dialog. when installing support for a new PC card, or in
some cases when changing the properties of existing drivers. 

Please note this refers only to Windows NT, Windows 2000 and Windows XP, other operating
systems do not enforce local privileges. 

When should the 
Network  bearer 
Override feature of 
Communication 
Centre be used? 

Communication Centre is set to automatically select the optimal network bearer signal, and by 
default will attempt to connect to a T Mobile Wireless LAN hotspot.   

The T-Mobile Communication Centre will check if there is a WLAN available and if so – use that 
to connect 

If no WLAN is available the software will automatically switch to UMTS/GPRS if available. 

 

The override feature should be used when e.g.  

-A T-Mobile hotspot is available and the user has a valid voucher, but there is a problem routing
traffic from the Access point to the core. 

-There is local interference which means Wireless Lan Communications are sub optimal. 

The software you 
are about to install 
does not contain a 
Microsoft Digital 
Certificate 

This message may be observed on Windows 2k and XP Operating Systems, when installing
hardware drivers (e.g. UMTS/GPRS PC cards), and is commonly seen. 

As long as you are certain of the source of the driver you may safely continue. 

What UMTS/GPRS 
communication 
speeds can I 
expect to obtain? 
  

UMTS/GPRS - The theoretical max is 53,6 kbps, but initial UMTS/GPRS terminals are 
expected to support less - only one, two or three timeslots limiting speeds to between 30 and
40 kbps. ´Unlike the other bearer services listed below the UMTS/GPRS does not use a fixed
channel and bandwidth but is a shared resource, controlled by the network, which means that 
data rates will also be limited by net. 

GSM - a fixed timeslot or channel supporting 9.6kbs or 14.4kbps. 
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9 Definitions and Abbreviations 

Terms Definitions 

APN Access Point Name  
 
The logical name of the point of entry to external packet data 
networks from a UMTS/GPRS network 

CHAP Challenge Handshake Authentication Protocol 
 
Negotiates a secure form of encrypted authentication by using 
Message Digest 5 (MD5), an industry standard hashing scheme. 

COM Communication port 

DNS Domain Name System  
 
DNS is a service that maps the internet domain space of logical 
names with IP addresses.. 

GGSN Gateway UMTS/GPRS Support Node 
 
A node that is one of the key functional elements of UMTS/GPRS 
and enables the transition of cellular networks with a PDN. 

GPRS General Packet Radio Service 
 
An extension of the GSM standard to enable packet switched data 
transfer. By the use of multiple time slots it is possible to receive 
higher bandwidth than on circuit switched connections. 

GSM Global System for Mobile Communications 

IETF Internet Engineering Task Force 

IMAP4 Internet Mail Access Protocol version 4 
 
The IMAP4 protocol is used by mail clients to access e-mails 
without the need for downloading them from the mailserver. 

IP Internet Protocol  

ISP Internet Service Provider 

KB Kilo Byte 
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Terms Definitions 

LCP Link Control Protocol 
 
Link Control Protocol establishes and configures PPP framing. 
PPP framing defines how data is encapsulated before 
transmission on the wide area network. The PPP standard framing
format ensures any vendors’ remote access software can 
communicate and recognize data packets from any remote access 
software that adheres to the PPP standards. LCP also includes 
procedures for negotiating which authentication protocol to use, as 
well as other link-layer related parameters (MTU size, multi-
link…). 

MB Mega Byte 

PAP Password Authentication Protocol 
 
PAP is a simple authentication protocol using unencrypted plain 
text credentials. This is the least sophisticated authentication 
protocol. 

PDP Packet Data Protocol  
 
In UMTS/GPRS standards, this is the protocol used in the external 
network (X.25, OSHP, PPP, IP). In the currently deployed 
networks, only IP is in use. 

PLMN Public Land Mobile Network 

POP3 Post Office Protocol version 3 
 
Protocol used by e-mail clients to get messages downloaded from 
a POP3 mail server. 

PPP Point to Point Protocol, 
 
A protocol for communication between two computers using a 
serial interface, typically a personal computer connected by phone 
line to a server. 

PSTN Public Switched Telephone Networks 

RAS  Remote Access Service  

SGSN Serving UMTS/GPRS Support Node  
 
A functional element of the UMTS/GPRS network that enables 
basic packet switched networking 

URL Uniform Resource Locator 
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Terms Definitions 

WINS Windows Internet Naming Service 
Manages the association of workstation names and locations with 
Internet Protocol addresses. 

 

 


